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General Information about this Manual 

This manual is designed to provide State employees with an overview of the eSTART Time and 

Attendance System. This manual provides basic procedures; however, you may need to seek 

clarification on specific agency procedures or rules from your agency personnel manager or 

supervisor. 

Nothing in this handbook should be construed to amend any laws, regulations, policies or 

procedures established by the State of Alabama or specifically the Alabama State Personnel 

Department.   

Certain procedures contained within this manual are subject to change or revision without prior 

notice. Employees will be notified as soon as possible when changes or revisions occur. 

All leave accruals and usages in eSTART are estimates and/or projections that are based on the 

concept that all employees earn leave and have leave to use. These estimates and projections may 

not be accurate. 
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Getting Started 

Importance and Benefits of eSTART 

It is important that your employees are compensated accurately. To make this happen, you need to manage 

employees worked and non-worked hours, as well as attendance issues, in an efficient and timely manner. 

The application supports your ability to perform these tasks so that the data sent to payroll is accurate. 

eSTART provides the following benefits to the State of Alabama: 

• Provide system-wide accountability in time and labor management. 

• Provide up-to-date accrual balances and projections. 

• Assists with standardization and accuracy of payroll process. 

• Provide employees access to their leave balances. 

• Eliminate manual processes ensuring cost and paper reduction. 
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Roles and Responsibilities 

Each employee and manager have responsibilities that are important in the payroll process. Each 

person’s role determines the responsibilities and tasks that he or she performs in the application. 

Common Employee Tasks 

Daily or on an as-needed basis, employees perform the following tasks: 

• Enter time data using a clock device or PC. 

• Request time off. 

• Review and approve timecard each pay period. 

• Review schedules, punches, and leave accruals. 

• View Inbox. 

• Request extended leave cases. 

• Request time off for an open and approved extended leave case.  

• Provide required leave documentation. 

• Submit requests for additional leave, as needed. 

Common Manager Tasks 

Daily, managers perform the following tasks: 

• Check for timecard exceptions and make edits when applicable. 

• Handle unexpected absences and missed time. 

• Enter non-worked time for employees. 

• Make schedule changes. 

Once a pay period or on an as-needed basis, managers perform the following tasks: 

• Schedule employees for a specific time period. 

• Monitor timecards and reports to facilitate payroll processing. 

• Review and approve timecards. 

• Request backup coverage. 

• Manage time off requests. 

• Initiate extended leave case for employee. 

• Create personal HyperFind queries. 

• Monitor extended leave events through leave views. 

• Enter hours for employees’ extended leave cases. 

• Submit an extended leave case for an employee. 

• Run leave reports. 
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Common Agency Administrator Tasks 

Once a pay period or on an as-needed basis, additional Agency Administrator tasks include: 

• Sign off timecards.  

• Perform final audit of time records. 

• Add specific pay codes to employee timecards. 

Common Leave Administrator Tasks 

Once a pay period or on an as-needed basis, additional Leave Administrator tasks include: 

• Determine eligibility and open leave cases.  

• Administer open leave cases, including documentation. 

• Enter hours for employees’ continuous leave cases. 

• Run leave reports 

Common State Administrator Tasks 

Once a pay period or on an as-needed basis, additional State Administrator tasks include: 

• Run reports. 

• View/Update People records. 
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eSTART Online Resources Link 

The eSTART log on page provides access to all the features of the eSTART application where you perform 

your time and attendance tasks.  In addition, there is a link to the eSTART Online Resources site for 

access to helpful resources. 

eSTART Online Resources site 

The link to the eSTART Online Resources site is located on the right side of the log on page.  This site 

contains training and support information, such as job aids, training videos, course guides, etc.  

Exercise 

Steps 

1 Click the eSTART Online 
Resources link. 

 

2 The site opens to the FAQ page 
where answers to certain 
questions can be found. 

 

3 There are menu options across 
the top of the page for accessing 
Job Aids, Training Materials and 
Video Tutorials. 

 

Click Job Aids. 

 

Job aids are quick reference 
guides which provide step-by-step 
instructions. 

 

Scroll down on the page to see the 
available job aids, sorted by role. 
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Steps 

4 Find the Manager Information 
section and click on Approve 
Timecard. 

 

The selected job aid opens in 
Adobe Acrobat Reader or a 
browser window and may be 
viewed, saved or printed if 
needed. 

 

 

 

5 Close the job aid by using the “X” 
in the top right corner of the page. 

 

6 If needed, you may select 
Training Materials for the course 
guides or Video Tutorials to view 
videos based on eSTART role. 

 

7 Close the eSTART Online 
Resources tab in your browser. 
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Logging On 

User Name and Password 

If you use a computer and log on to the State’s network, your User Name and Password will be the same 

as used to log into that network for the eSTART system. This is usually your full email address:  

firstname.lastname@agency.alabama.gov.   

If you do not have a network ID, your User Name will be provided by your Agency Administrator. The User 

Name will ordinarily be firstname.lastname. An initial password will also be provided that must be changed 

at first logon. 

Exercise 

You, as a manager, log on to the eSTART application to review and work with your employees’ timecards 

and scheduling data. It is a best practice to review this application each workday. 

 

Steps 

1 Access the eSTART log on page. 

2 Enter your user name and password in the designated fields. 

3 Click the Log On button or press the Enter key on the keyboard. 

 

 

NOTE 
The URL for the eSTART production application is below.  You may create a desktop 
shortcut or add to Favorites list for quick access. 
 
https://estart.alabama.gov/wfc/htmlnavigator/logon 

  

https://estart.alabama.gov/wfc/htmlnavigator/logon


eSTART Course Guide for Managers   

 

7 

The Inactivity Timeout and Signing Out  

eSTART provides security to prevent other people from accessing your information. It also helps keep your 

employees’ information confidential. 

Regaining access after the inactivity timeout 

The inactivity timeout protects sensitive information in the application. If the application does not detect 

activity within a specific amount of time, it attempts to automatically log you off. To regain access to the 

application, you must click Yes to remain logged in. 

 
 

 

Best Business Practice 

The inactivity timeout message displays if there is no activity for 30 minutes. 

 

 

Caution 

If you do not click Yes after receiving the inactivity timeout, you are logged out of the 
application. You will lose all unsaved edits. 

Signing Out of eSTART 

Upon completion of your tasks, you must sign out of eSTART to ensure that your employees’ information 

remains confidential.  The Sign Out link is located on the upper right side of the page below the user 

name. 

 

 

 

Tip 

eSTART is a browser-based application. However, you should not use the browser’s 
navigation controls—the Back button on the toolbar, for example. Only use the links inside of 
eSTART to do your work. 

  



 eSTART Course Guide for Managers 

 

8 

Navigating eSTART 

Introducing the Navigator  

After you log on to eSTART, your Navigator pane displays. The Navigator is a customized view of the time 

and labor information that is important to completing your daily work tasks. It is designed to be simple with 

easy-to-use views. You should take a few minutes to get acquainted with its navigation features. 

Navigator Components 

The Navigator consists of four main components:  Alerts, Workspace tabs, Widgets and the Related 

Items pane. 

 

 

Workspace 
Components 

Description 

Alerts Your Navigator contains two alerts, Exceptions and Requests, which have been configured to 
notify you when specific events or conditions occur. Because the alerts always display in your 
Navigator, you will know immediately if something requires your attention. 

Workspace tabs Your Navigator contains two other workspaces. A workspace is a layout designed to 
accommodate a specific business need.  The manager workspace is the default or “home” 
workspace.  Access the employee workspace from the Add Workspace (+) tab when needed. 

Widgets Widgets are self-contained components within a workspace that are used to access specific 
eSTART information or tasks. 

Related Items 
pane 

Widgets that are available, but not displayed in the selected workspace are accessed via the 
Related Items pane. They may be clicked and dragged into an open workspace or clicked to 
open the widget in a temporary workspace. 
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Viewing Workspaces 

Your Navigator is configured to provide more than one workspace.  The default workspace for Managers 

is the Manager workspace, but you may select your Employee workspace when needed.  This workspace 

displays your individual timecard, calendar and leave functions. 

Example 

Steps 

1 To open the Employee 
Workspace, click the Add 
Workspace (+) tab and choose 
Employee Workspace. 

 

2 The Employee workspace opens 
in a separate tab.  

 

3 After selecting the workspace, you 
may switch to a different 
workspace by selecting the 
associated tab.  

Note that your home workspace 

will be indicated by a  in the 
tab.  The refresh button is used to 
refresh the page. 

 

4 To close a workspace, click the X 
on the tab.  The refresh icon may 
be used to refresh the page. 
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The Related Items pane 

 
Managing Open Widgets 

To maximize a specific widget to fill the workspace, click the Maximize button in the upper right-hand corner 

of the widget. Click the same button in a maximized widget to return it to the default widget size.  

 

Widgets that are available but not displayed in the selected 

workspace are accessed via the Related Items pane. They 

may be clicked or dragged into an open workspace or 

clicked to open the widget in a temporary workspace. 

• Click the arrow in the upper-right corner to open and 

close the Related Items pane.  

• Use the scroll buttons at the top or bottom of the pane 

to view additional widgets within the pane.  
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Editing Time Data for Non-Exempt Employees 

Accessing and Viewing Employees’ Timecards 

When non-exempt employees forget to punch, or punch in early or late, their pay may be impacted. 

Therefore, it is your responsibility to resolve any discrepancies to ensure that employees are paid correctly. 

In addition, unresolved missing punches may delay payroll processing. The Reconcile Timecard View 

allows you to recognize and resolve the most common types of exceptions. From Reconcile Timecard, 

you may open employees’ timecards and make any needed adjustments prior to payroll processing.  

Common Areas of eSTART Pages 

Before exploring employee timecards, it is important to note that eSTART pages contain five common 

areas that are used to quickly access different functions:  My Views Menu, Selection Menu, Search Tools, 

the Work area, and the Go To Menu. 

 

Areas Description 

My Views Menu Allows you to access employee information in summarized, easy-to-read formats. 

Selection Menu Allows you to Select All employees, temporarily edit the columns that display, filter the 
data in the view, add or delete pay codes or access schedules.  On the right side of the 
page is a Refresh button and a Share button to print the page or export data. 

Search Tools The Time Period drop-down allows you to select the timeframe for which you want to view 
schedules and timecard data.  There is also a Range of Dates icon to set your own time 
frame as well as a Show drop-down for selecting the group of employees to view. 

Work Area The work area contains detailed information about the employees in the selected time 
period, as well as the action bar, which contains selections for modifying data. 

Go To Menu Allows you to quickly jump to other widgets to view or edit employee information. 

 

 

NOTE 

Reconcile Timecard View is one of two places in eSTART where employee exceptions may 
be edited. The second is the Exceptions widget which will be covered in a later module. 
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The Reconcile Timecard page shows a quick view of existing exceptions.  Each exception displays in a 

separate column and if the exception is present in the timecard, a check mark displays.  A description of 

each exception is below. 

Exception Type Description 

Unexcused Absence Employee is scheduled to work but did not punch in at all. 

Missed Punch The employee did not punch in or out either for lunch or at the end of the 
day.  In other words, their punch is missing. 

Early In Employee punched in early.   

Late In Employee punched in late. 

Early Out Employee punched out early. 

Late Out Employee punched out late. 

Long Break Employee took a long lunch break. 

Short Break Employee took a short lunch break. 

Unscheduled Hours Employee punched in but is not scheduled to work. 

Holiday Skipped Non-exempt employee who did not work the scheduled day before and 
scheduled day after a holiday. 

Exercise 

In reviewing Reconcile Timecard, you notice that several employees have time and attendance 

exceptions. Open each employee’s timecard to review and adjust the data. 

Steps  

1 From the Time Period drop-down 
list, select Previous Pay Period. 

The Show drop-down defaults to 
All Home and Transferred-In.  

 

2 Select all employees using the 
Select All Rows icon. 

 

See Tip following the exercise for 
additional selection methods.  
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Steps  

3 Click Go To>Timecards. 

 

NOTE:  The Timecards link is 
also available from the Related 
Items pane. 

 

 

4 If you selected more than one 
employee, do one of the following: 

• Click the Next scroll button 
to move to the next 
employee. You may use the 
Previous scroll button to 
move to a previous 
employee. 

• Select an employee from the 
Name drop-down list. 

 

 

 

Tip 

There are various ways to select employees in an eSTART widget:  

• Hold the Ctrl key and click your mouse to select more than one employee in the listing. 

• To select a group of employees listed together, use one of these methods:  

o Click the first employee, then hold the Shift key and click your mouse to select 
the last employee. This will select all employees in-between. 

o Click and drag the mouse to select multiple employees. 

o Choose the Select All Rows icon to select all employees. 

 

 

Tip 

To return to the Reconcile Timecard widget 
from an open timecard, click on the Manager 
Workspace tab or close the Timecards tab 
using the X. 

  



 eSTART Course Guide for Managers 

 

14 

Non-Exempt Timecard Overview 

There are four main areas on a timecard: Selection Menu, Timecard Header, Timecard Tabs and 

Timecard Workspace. 

 

Timecard Area Description 

Selection Menu Provides selections for performing timekeeping tasks. 

Timecard Header Displays the selected employee’s name and ID, as well as the time period. 

Timecard Workspace  Displays the following information: 

• Grid containing dates for the selected time period. 

• Time entry totals, including shift, daily, and cumulative hours. 

Shift Total - Calculated total hours of all shifts worked on the selected day 
(excluding totals for non-shift items such as pay codes).  

Daily Total - Calculated total hours of the selected day, including pay codes. 

Period - Cumulative total up to and including the selected day. 

• Schedule - The employee’s schedule for the day. 

Timecard Tabs 

 

Display additional information about how eSTART tracks employee hours. Four default 
tabs display: 

• Totals -Displays the timecard totals.  

• Accruals - Displays accrual codes and available leave balances based on 
the date selected. 

• Historical Corrections - Displays historical correction information. 

• Audits - Displays audit trail information. 
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Visual Indicators 

Visual indicators display on a timecard when an exception occurs. For example, an employee might forget 

to clock in or out, which causes a missed punch exception. An employee might clock in early or late, which 

causes a punch exception. 

 

Visual Indicator Description 

Blue indicator on punch An excused absence for the day, such as Annual Leave, Sick Leave, or Holiday 

Red indicator on date An unexcused absence for the day 

Red indicator on punch An exception, such as a late or early punch, or a short or long break 

Green indicator on punch Exception has been marked as reviewed 

Solid-red cell A missed punch 

Purple text A transaction that was added by the eSTART application  

Blue comment indicator  One or more comments are attached to the punch  

Calculating Totals 

To see the effects of a change on the employee’s time before saving, use the Calculate Totals feature 

on the Selection Menu below. 

 

Refreshing and Saving Data in Timecards 

When you add and modify timecard data, eSTART displays your edits but does not save them 

automatically. You must tell the application to save the data by selecting the Save button.  If you do not 

wish to save the data, use the Refresh button to restore the original data. 

 

 

  



 eSTART Course Guide for Managers 

 

16 

Marking/Unmarking Exceptions as Reviewed 

Once you have reviewed an exception and resolved it, you may mark the exception as reviewed. The 

exception will remain visible in the timecard, but the red indicator will change to green. At any time, you 

may choose to unmark an exception as reviewed. 

NOTE:  Marking an exception as reviewed is optional. 

Exercise 

On Wednesday of the previous pay period, Junior Manager arrived early to work because he needed to 

leave early. Mark the exception as reviewed so it does not have to be checked again. 

Steps 

1 From Reconcile Timecard, select 
Junior Manager and Penny 
Punch and access their timecards 
using the Go To menu. 

NOTE: You may hold the Ctrl key 
and click to select more than one 
employee.  

2 From the timecard of Junior 
Manager, select the 7am punch. 

To mark an exception as 
reviewed, right-click on the punch. 

 

3 The Punch Actions window 
displays.  Select Mark as 
Reviewed. 

 

Repeat the process to mark the 
4pm punch as reviewed. 

 

NOTE: To unmark an exception 
as reviewed, click Unmark as 
Reviewed. 

 

4 Review the results.  The red bar is 
now green. 

 

 

 

5 Click the Save button. 
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Attaching Comments to Punches 

Comments are predefined descriptive phrases you attach to a punch to provide additional, useful 

information about that transaction. You may attach as many comments as needed to explain the punch. 

Exercise 

On Wednesday of the previous pay period, Junior Manager arrived early to work because he needed to 

leave early. You have marked the exception reviewed. Now add a comment that the early arrival was 

excused. Attach an Early-Approved comment to the employee’s 7:00 a.m. punch. 

Steps 

1 In the timecard, right-click the cell 
containing the exception. 

 

2 The Punch Actions window 
displays.  Click Comment. 

3 Open the Select Comment drop-
down list.   

From the list of comments, select 
Early-Approved. 

 

Click OK. 

 

 

 

4 Click the Save button. 

 

5 Confirm that the blue bubble icon 
displays in the timecard.  Hover 
the cursor over the icon to view 
the comment. 

 

 
NOTE:  To remove a comment, right-click on the field and select Comments.  Click the X to the left of the 
comment to delete it.       
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Adding Missed Punches  
When an employee forgets to punch in or out, a solid-red box displays in the timecard. To add the punch, 

click the cell and type the missed time.  

Exercise 

Junior Manager notified you that he forgot to punch out on the second Thursday of the previous pay 

period. The employee ended his shift at 5:00 p.m. Access the employee’s timecard and add a 5:00 p.m. 

out punch on the employee’s timecard for the second Thursday of the previous pay period. 

Steps 

1 Access the employee’s timecard.  

2 Select Previous Pay Period from 
the Time Period drop-down list. 

 

3 Click the out-punch cell containing 
the missed punch exception. 

Type 5p or 5pm in the cell. 

 

NOTE: Always use the p or pm 
when keying time into a cell. 

 

4 Right-click the cell again and 
choose Comments.  Select the 
Missed Punch comment. 

 

Click OK. 

  

5 Another option for adding a 
missing punch is available if the 
employee is assigned to a 
schedule.  

Open the Quick Actions icon and 
click Add Missing Punch.  The 
cursor changes to a cross.  Click 
in the cell of the missing punch 
and the out punch will populate.  
This may only be used to populate 
a missed beginning or end of day 
punch. 

Click the Quick Actions icon 
again to close the menu. 

 
 

 

6 Select Calculate Totals to ensure 
the changes you made are 
correct. Then Save. 

       
 

 

Best Business Practice 

You must correct all Missed Punch exceptions on the timecards. Administrators will not have 
the ability to sign-off on the payroll until all missed punches are corrected. 
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Adding Pay Code Hours to Timecards 

Pay codes keep track of the type of worked and non-worked time that is entered in the timecard.  Examples 

of pay codes include: Annual Leave, Sick Leave and Personal Leave Day.  

It is important that hours are tracked to the correct pay code so that the employee is paid correctly. There 

are times when you might have to edit an employee’s timecard and use a pay code to track his or her 

worked or non-worked time, for example, when the employee calls in sick. 

Exercise 

Junior Manager was sick on Monday of the previous pay period. His timecard was not updated and 

eSTART flags the date as an unexcused absence. Edit the employee’s timecard for the Previous Pay 

Period to reflect the sick leave. 

Steps 

1 In the timecard, select the Sick 
Leave Taken pay code from the 
Pay Code drop-down list. 

 

 

2 Click the Amount cell next to the 
pay code you selected. Enter the 
number of hours, using an 
acceptable format (chart below).  

 

3 Select Calculate Totals to ensure 
the changes you made are 
correct. Notice the Daily and 
Cumulative hours have now 
updated based on your changes.  

4 Once you have determined the 
timecard/hours are correct, select 
the Save button. 

 

NOTE: If the pay code edit 
excuses an absence, the red bar 
will change to blue.   

 

 

 

 

NOTE 

You cannot add a pay code to a row that contains punches.  You must insert a separate row for 
the pay code transaction. 
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Acceptable Formats for Entering Pay Code Hours 

Acceptable Format Example Interpretation by eSTART 

Leading zeroes (optional) 07  7:00 hours  

Colon 7:30  7:30 hours  

NOTE: If you enter hours without a colon or a leading zero, 
eSTART interprets your entry as is, which may be a much 
larger number of hours than you intended. For example, if you 
enter 730 (without the colon or leading zero), eSTART 
interprets that as 730 hours. 

Decimal 8.5  8:30 hours  
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Deleting Punches  

As a rule, you should not change or delete punches from timecards because they represent actual times 

that employees started and stopped working. However, there are some exceptions to this rule. For example, 

an employee might punch twice when starting or ending a shift. When this occurs, you should delete the 

extra punch. The Audits tab provides a record of all timecard edits, including any deleted punches. 

Exercise 

Penny Punch could not remember if she punched in at the beginning of her shift on the second Monday 

of the previous pay period. She punched in a second time to ensure that she recorded her start-of-shift 

time. While reviewing the employee’s timecard, you notice that two in punches display for the employee’s 

start of shift on Monday. You want to delete the employee’s second in punch of 8:02 a.m. 

Steps 

1 First, select the 8:02am punch 
and add a comment for audit 
purposes. 

 

2 Right-click to open the Punch 
Actions window.  Select the 
Comments icon, then open the 
Select Comment drop-down. 

Select Multiple Punches. 

Click OK. 

 

 

3 SAVE THE PAGE BEFORE 
DELETING THE PUNCH. 

 

4 Once the comment has been 
saved, click the 8:02am cell. 

 

5 Press the Delete key on the 
keyboard to delete the punch.  
Press the Tab key. 

6 Save the change.  

 

7 The punches are now correct. 

 

 

  



 eSTART Course Guide for Managers 

 

22 

Marking/Unmarking Exceptions as Reviewed 

As discussed earlier, once you review an exception and resolve it you may mark the exception as reviewed. 

The exception remains visible in the timecard and in customized views, but no longer displays in exception 

reports or queries. Once the exception is marked as reviewed, a green bar displays in the cell containing 

the exception.  

You may unmark an exception as reviewed at any time. 

NOTE:  This exercise demonstrates a second method that may be used to mark multiple punches 

as reviewed.  Marking an exception reviewed is optional. 

Exercise 

On Tuesday, Penny Punch arrived late to work because of traffic. You want to mark the exception as 

reviewed so that you do not re-check it again later.  She asked permission to work an extra hour in order 

to make up the time, which you approved.  You may mark the late out exception as reviewed and add a 

comment to her 9:00 a.m. punch as a reminder of the reason for the late punch. 

Steps 

1 In the timecard, there are two 
punches to be marked as 
reviewed.   

2 Open the Quick Actions icon.  
Select Mark/Unmark.  The cursor 
changes to a cross.  Click the first 
punch to change the red bar on 
the 9am punch to green. 

 

Click the second punch to mark 
the 6pm punch as reviewed. 

 

Click the Mark/Unmark icon 
again to change the cross back to 
the normal cursor. 

Click the Quick Actions icon 
again to close the menu. 

NOTE: To unmark an exception 
as reviewed, repeat the process.  
The green bar will be changed 
back to red. 

 

 

3 Review the results. 

 

4 Add a comment to the 9am 
punch by right clicking the punch 
again. 
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Steps 

5 The Punch Actions window 
displays.  Click Comments. 

 

6 Open the Select Comment drop-
down list.   

From the list of comments, select 
Traffic. 

 

 

 

 

7 To add an additional comment, 
select Add Comment.   

 

8 Then choose Late Approved. 

Click OK. 

 

 

9 Click the Save button. 

 

10 Confirm that the blue bubble icon 
displays in the timecard.  Hover 
the cursor over the icon to view 
the comments. 
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Overriding Punches 

When employees punch in or out for their shifts, a punch may be misinterpreted by the system if a punch 

is missed during the day. An in punch may be interpreted as an out punch or vice versa. It is also possible 

that an exception related to a lunch break will also be applied if an employee takes a lunch break shorter 

than their assigned lunch rule. If a punch is incorrectly labeled or a lunch exception is incorrectly applied, 

you may override the punch to correct the error. 

Exercise 

You needed Penny Punch to return from lunch 30 minutes early on Wednesday of the previous pay 

period, but she normally receives a 60-minute lunch. The system recorded her return punch from lunch as 

a Short Break exception. To get rid of the exception for this circumstance, you may choose to override the 

exception.  

Steps 

1 In the timecard, select the punch 
you want to override.  

 

Right-click the 12:30pm punch. 

 

2 The Punch Actions window 
displays.  Select Edit. 

 

3 The Punch window displays. 

 

Select 30 Minute Lunch from the 
Override drop-down list. 

 

Click OK. 

 

4 Click Save. 

 

 

 

NOTE 

Any overtime or compensatory time resulting from this type of exception should be managed 
according to Agency policy. 
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Totals Tab  

The Totals tab displays the employee’s worked and non-worked time for the pay period.  

Click the gray tab in the lower section of the timecard view to expand the Totals and Accruals section of 
the timecard.   

 

The Totals tab displays.  The left drop-down box defaults to All, but may be changed to Shift, Daily or 

Period to Date to view totals as needed.   

The right drop-down box defaults to All but may be changed to Account to display the Account column or 

Pay Code to hide the Account column. 

The following illustration shows the Totals Tab. 

 

Description of the columns in the Totals section:   

Column Description 

Account The labor level to which the employee is assigned.  Further information may be found 
on this in the employee’s People Editor. (Agency/Division/Work Location/Manager 
ID/Job Classification Code) 

Pay Code The pay code to which the worked or non-worked time is assigned.  Any overtime or 
comp time will display here as well. 

Amount The number of hours earned or taken in each pay code. 
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Accruals Tab 

The Accruals tab displays the employee’s accrual balances for each accrual code. You may quickly see 

up-to-date accrual balances, such as Annual Leave and Sick Leave. 

The following illustration shows the Accrual tab.  

Example 

Review the leave balances for Penny Punch. 

 

 

Column Description 

Accrual Code The type of accrual balance, such as Annual Leave or Sick Leave. 

Accrual Reporting Period The leave reporting period (current year). 

Accrual Available Balance  The accrual balance from the payroll system as of the date selected in the timecard.   

Accrual Planned Takings  The total amount of time scheduled to be taken, from the date selected in the 
timecard through the end of the Reporting Period (12/31). 

Accrual Pending Grants The total accruals projected from the date selected in the timecard through the end of 
the Reporting Period (12/31).  The projections assume the employee will work the 
appropriate number of hours to earn the accruals. 

Accrual Ending Balance The accrual balance as of December 31st, including Pending Accruals and Planned 
Usages. 

 
NOTE:  The Historical Corrections tab is used to view historical corrections and the Audits tab displays 
audit trail information.  
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Viewing the Audits Widget 

The Audits widget is located on the Related Items pane. It is also available from the Totals tab at the 

bottom of the timecard or from the Go To menu. All timecard changes are logged here for audit 

purposes, including timecard approval. The tab also lists punches made from timestamping. You may 

filter the data using the Category and Type of Edit drop-down lists. 

Example 

From the timecard of Penny Punch in the Previous Pay Period, select Go To>Audits.  Review the 

changes made to Penny’s timecard. 

 

Column Description 

Date/Time The original date/time of the entry. 

Type The type of edit that was performed. 

Account The account to which the edit is attributed, if different from the primary account. 

Pay Code/Amount The pay code and number of hours assigned, if applicable. 

Work Rule The work rule used with the edit, if different from the employee’s primary work rule. 

Override The type of entry that this edit is replacing or canceling, if applicable. 

Comment The comment attached to the edit. 

Edit Date/Time The effective date and time of the edit. 

User The user name of the person who edited the transaction. 

Data Source The component of the application where the edit occurred. 
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Editing Time Data Using the Exceptions Widget 

Using the Exceptions Alert 

A second option for editing time data is available from the Exceptions widget.  This widget is like the 

Reconcile Timecard View and may be used to edit exceptions in the timecard view. 

Your Navigator is configured to receive exceptions alerts. If one of your employees has triggered a time 

exception that requires your attention, you will see an Alerts icon at the top of your Navigator when you log 

in. 

 

Click the Alert icon to see a list of the exceptions. Select an employee from the list to view the details of 

the exception. The Exceptions widget displays.  The X may be used to close the alert. 

 

The View All button opens the Alerts and Notification Widget.  This widget is used to view a history of 

alerts.   

 

Once opened, the alert category may be changed from Exceptions Alert to Request Manager Alert by 

selecting the round icons on the widget.  The icon changes to an orange color when selected. The third 

icon is for “uncategorized” alerts and is not used.  Use the X to close the tab. 
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Viewing the Exceptions Widget   

When non-exempt employees forget to punch, or punch in early or late, their pay may be impacted. 

Therefore, it is your responsibility to resolve any discrepancies to ensure that employees are paid correctly. 

In addition, unresolved missing punches may delay payroll processing. The Exceptions widget allows you 

to recognize and resolve the most common types of exceptions. 

The Summary View 

Select Exceptions from the Related Items pane.  The Exceptions Summary page displays. 

 

In the Exceptions Summary view, the widget displays a list of your employees for the time period and 

HyperFind selected at the top of the widget. It organizes the employee exceptions by type. The exception 

types displayed include missed punches, punch exceptions (such as late or early), lunch exceptions (short 

or long), unexcused or unscheduled hours, and holiday skipped. 

 

Exception Type Description 

Missed Punch The employee did not punch in or out either for lunch or at the end of the 
day.  In other words, their punch is missing. 

Punch Exceptions Employee punched in or out early or late, based on their schedule.   

Lunch Exceptions Employee took a long or short lunch break. 

Unexcused/Unsched Unexcused - Employee is scheduled to work but did not punch in at all. 

Unscheduled - Employee punched in but is not scheduled to work. 

Holiday Skipped Non-exempt employee who did not work the scheduled day before and 
scheduled day after a holiday. 

Total The sum of the totals in all exception columns.  The overall totals are at 
the bottom of the page. 
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View Timecards by Exception Type 

To access the timecards by exception type, select the employee(s), open the View Exceptions icon and 

select the exception type. 

 

The timecards of those employees with this exception will display. In this example, Missed Punch was 

selected.  When the exception applies to more than one employee, the names will display in the drop-

down list on the left side of the page.  The Search field will allow a search for an employee name, or the 

employee name may be selected from the list.  There is also a scroll bar to the right of this field to allow 

scrolling between employee timecards.  There is an indicator for Showing Only Days with Exceptions 

that displays at the top of the page as a reminder. 

 

Edit the timecards as needed, following the same methods as outlined in the previous section.  Then 

Save each timecard. 

Once the exceptions have been corrected, return to the Exceptions Summary page, click the Refresh 

button and the number of exceptions will be updated.  In this example, there are no longer any missing 

punch exceptions. 
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Scheduling Employees 

Introducing Scheduling 

Using the application’s scheduling capabilities, you may quickly compare the differences between worked 

and scheduled time and identify additional workload needs. You may also track employees’ absences as 

well as early or late arrivals. To take full advantage of these capabilities, you need to create, review, and 

maintain accurate schedules for employees in the application.  

Schedules are used for two key reasons: to match staffing to workload requirements and to manage time 

and labor data for individual employees. 

When you manage time and labor data for individual employees with schedules, you may: 

• Track attendance. 

• Track exceptions such as when an employee is early, late, or absent. 

• Schedule and view non-worked hours, such as annual leave in advance. 

• Pre-populate exempt employee timecards with standard schedule information. 

Scheduling process 

The scheduling process helps you identify whether your employees’ schedules meet the workload 

requirements. The following illustration shows the five main stages in the scheduling process: 

 

 

  

Assess workload 

Each division has unique staffing needs, which is driven by its workload requirements for a given period. 

Often managers assess the amount of work that needs to be performed in their division and then evaluate 

how to meet those demands with their workforce. You typically know your workload before you work with 

eSTART scheduling. 

Update group assignments 

New hires may be assigned to a schedule group to provide exception reporting. You may change these 

initial assignments as your staffing needs change. 

Meet workload requirements 

After you identify your workload needs for a specific time period, you may assign schedules to employees 

in your division to meet those needs. Assigning schedules to employees allows you to compare employee 

work hours to scheduled hours to identify discrepancies and take any necessary action. 

  

Assess 
anticipated 
workload 

for a period 

Update staff 
Schedule 

group 
assignments 

Schedule 
staff to 

meet the 
workload 

Evaluate 
and publish 

the 
schedule 

Maintain 
the 

schedule 
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Evaluate the schedules 

After you finish scheduling your employees for a given period, you need to evaluate the final schedule to 

ensure that it meets your workload needs for that time period. You may evaluate each employee’s total 

scheduled hours to ensure that the employee meets the requirements. You may also view scheduled hour 

totals to ensure alignment with your budget and keep overtime to a minimum. 

Maintain the schedules 

There may be times when you need to change schedules so that the information in eSTART is accurate 

and your workforce is paid correctly. 

Scheduling terms 

The following table describes key scheduling terms used in eSTART:  

Term Description 

Schedule The plan for worked and non-worked days for an employee in the past, present, and the 
future. 

Schedule Groups  A way to organize employees for easier and quicker scheduling. Usually employees work the 
same schedule, but you may also group employees to make it easier to select and sort.  

Shift The time an employee is expected to work. A shift contains a start time and an end time. 

Totals Rows that display the sum of the scheduled hours for all employees, as well as the total 
number of employees scheduled for the selected time period. 
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Navigating the Schedule Editor 

The Schedule Editor allows a manager to schedule employees worked and non-worked hours. Using the 

Schedule Editor, you may: 

• Add, edit, and delete shifts. 

• Assign employees to schedule groups. 

• Add pay codes for worked or non-worked hours. 

 

Columns Description 

Name  Lists the employee names. 

Sch Hrs.  Displays total number of scheduled hours by employee for the selected time period, with 
lunch deducted, if applicable. 

Date cells For each day in the selected time period, displays shift start and end times. A date cell 
may also display pay codes to identify scheduled non-worked hours. 

 

 

NOTE 

Pay period selections are not available in the Time Period drop-down from the Schedule 
Editor. Use the Range of Dates selection if a broader time period is needed. 

• A Pay Period is a time period from 1st – 15th or 16th-31st.   

• A Schedule Period is the FLSA (Fair Labor Standards Act) week.  It is a one-week 
span of time, from Saturday to Friday. 
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Using Groups to Assign Schedules to Employees  

When you assign an employee to a schedule group, you specify how long the employee will belong to the 

group. If there is no defined end to the group assignment, you may indicate that the employee belongs to 

the group indefinitely.  

Exercise 

Sandy Stamp is not currently assigned to a schedule group. She works a schedule of 8:00am - 5:00pm 

with a 60-minute lunch. Therefore, you will assign her to a schedule group effective on previous month 

with no end date. 

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

 

2 Select the Range of Dates icon.  

For this exercise, choose the first 
workday of the previous month as 
the Start Date.   

 

The End Date will be today’s date. 

 

Click Apply. 

 

 

3 Select View>By Schedule 
Group. 

 

Then highlight Sandy Stamp in 
the Ungrouped section.  

 

Right-click on Sandy’s name. 

 

 

 

 

4 The selection window displays. 

 

Choose Add to Group. 
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Steps 

5 The window expands to allow the 
group to be selected. 

From the Schedule Group drop-
down list, select the applicable 
schedule group. 

 

6 The Start Date defaults to the 
start date selected from Time 
Period. 

7 For the assignment to be in effect 
with no end date, select Forever. 

 

If the schedule is to be temporary, 
select the date from the End Date 
calendar. 

 

8 The check mark for Remove 
employees from other schedule 
inheritance groups for the 
selected date range remains 
selected. 

9 Click Apply. 

Sandy is now assigned to the 
schedule group.  

10 Click Save. 

 

 

 

Tip 

You may remove an employee from a Schedule Group by selecting Remove from Group from 
the selection window.  

 

 

NOTE 

If a schedule group is needed, (not available in the list) contact your Agency Administrator to 
have it added. 
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Adding or Editing Shifts Using the Shift Editor   

When creating and editing more complex schedules, use the Shift Editor. It has tools that make it easier 

for you to create and edit shifts with several segments, shifts with transfers, shifts that cross the day divide, 

and other complex shifts. 

Exercise 

On Monday of the next schedule period, you need Penny Punch to work the following shift segments: 

• Regular shift from 8:00 a.m. to 12:00 p.m. 

• Lunch break from 12:00 p.m. to 12:30 p.m. 

• Regular shift from 12:30 p.m. to 4:30 p.m. 

Follow the exercise below to edit Penny’s shift. 

NOTE:  Shift times must always be entered in 15-minute increments.   

Steps 

1 From Schedule Editor, return to 
the By Employee view by 
selecting View>By Employee. 

 

2 From the Time Period drop-down 
list, select Next Schedule Period. 

 

Select Penny Punch. 

 

3 Right-click the Monday cell where 
the shift is to be edited.  The 
window displays to allow editing. 

 

4 Select Edit. 
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Steps 

5 The Edit Shift window displays. 

 

6 To modify her existing shift to 
allow 30 minutes for lunch and to 
leave 30 minutes early, edit the  

 

Break End Time to 1230p 

Regular Start Time to 1230p 

Shift End Time to 430p  

 

NOTE:  Shift times must always 
be in 15-minute increments. 

 

7 Click Apply. 

 

Review the schedule and if 
correct, click Save. 

 

 

 

NOTE 
Another method for adding the shift is to click in the cell and manually key the shift times, i.e. 
8a-5p, 730a-430p. 
 
Also, if a cell does not contain an existing shift, right-click in the empty cell and select Add 
Shift from the menu. 

  

 

Tip 
Enter time using a 12-hour format with either am/pm or a/p abbreviations. For example, you 
may enter 8:00am to 5:00pm or 8a-5p.  You may also copy and paste shifts using Ctrl-C and 
Ctrl-V. 
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Deleting Shifts from Employees’ Schedules 

Sometimes an employee is unable to work a scheduled shift. When this happens, you need to delete the 

shift from the employee’s schedule to prevent the application from flagging the absence as unexcused. 

Exercise 

Penny Punch, who is currently scheduled to work on Tuesday of the next schedule period, will not be 

working on Tuesday. Access the Schedule Editor and delete her schedule for Tuesday.  Select Next 

Schedule Period. 

Steps 

1 Select the shift on Tuesday for 
Penny.  

2 Right-click on the shift and the 
window will display. 

 

3 Select Delete to remove the shift. 

 

4 Click Save.  
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Scheduling Non-Worked Hours 

Non-worked hours include time such as sick leave, annual leave, or jury duty. You may schedule your 

employees’ non-worked time when you are made aware of the non-worked time.  

Exercise 

Penny Punch has been called to serve jury duty on Thursday of the Current Schedule Period. Because 

you know about it in advance, you want to schedule the time so that you do not forget. 

Steps 

1 From the Related Items pane, 
select Schedule Editor. 

 

2 From the Time Period drop-down 
list, select Current Schedule 
Period. 

From the Show drop-down list, 
select All Home and Transferred 
In.  

 

 

3 Locate Penny’s row and click the 
cell in the row where you want to 
schedule non-worked hours. 

 

Then right-click to display the Edit 
Shift window. 

 

Select Add Pay Code. 

 

4 The Add Pay Code window 
displays. 
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Steps 

5 In the Effective Date field, 
confirm the date selected. (Or, if 
incorrect, enter the correct date.) 

 

6 From the Pay Code drop-down 
list, search if needed, then select 
Jury Duty. 

7 In the Amount field, enter 8 
hours. 

8 The Override Shift check box is 
selected. 

• To override the 
employee’s entire shift, 
select Whole Shift. 

• To override part of the 
employee’s scheduled 
shift, select Partial Shift. 

For this exercise, Whole Shift will 
remain selected. 

9 In the Start Time field, the shift 
start time will automatically 
default.   

 

NOTE:  For partial shifts, enter the 
correct start time of the leave.  Be 
sure to enter am/pm correctly. 

10 Click Apply and then click Save. 

 

11 Highlight Penny Punch and select 
Go To>Timecards.  Verify the 
pay code in Penny’s timecard.  
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Reviewing Employee Data in eSTART 

eSTART pages present customized views of employee information in a summarized, easy-to-read format 

so that you may quickly analyze and respond to time, labor and scheduling needs.   

My Views 

The My Views widget is the default widget for the Manager Workspace.  Reconcile Timecard is the default 

selection, but there are other widgets available in the drop-down list. Other widgets available from the My 

Views drop-down are in the table below with a brief description.   

 
 

View Description 

Reconcile Timecard View Display exceptions, Holiday skipped, and totals up to date. 

Accrual Detail Balance View Employee leave ending balances for each leave type. 

Accrual Reporting Period 
View 

Employee accrual leave balances, pending usages, pending accruals and 
ending balances, by employee. 

Custom Field Reporting View Includes employee information for pay rules, scheduled group, lunch, 
employee type, approver, current or arrears. 

Employee Holiday Credit View Holiday Earned and Holiday Taken hours by employee. 

Employee Hours View Employee hours: Regular and Non-Worked, Comp and OT. 

Employee Information View Includes employee information for pay rules, labor account, hire date, 
employment terms, current or arrears, scheduled group, assigned manager. 

Leave Cases View Includes leave reasons, leave frequency, leave case status, leave category, 
initial leave request date. 

Leave Hours View Includes total leave hours, leave case status, last date of committed paid and 
unpaid leave time, leave end date (if one is provided). 

On Premises View Non-exempt employees currently at work. 

Pay Period Close View Final review of your employee time records, displays indicators for employee 
and manager approvals. 

All WTK Exceptions This widget is used to track exceptions in the system.  Reconcile Timecard is 
the preferred widget for viewing exceptions. 

Count All WTK Exceptions This widget is used to track exceptions in the system by type.  Reconcile 
Timecard is the preferred widget for viewing exceptions. 
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NOTE 

Information from any widget may be printed from the Share icon.  You may also export the 
data to an Excel (.xls) or CSV (Comma Separated Value) file to make it available to other 
applications such as Excel. 

 

Exercise 

You want to look at how your employees are set up in eSTART. 

Steps 

1 Open the My Views drop-
down and choose 
Employee Information 
View. 

 

2 From the Time Period 
drop-down list, select 
Current Pay Period. 

 

From the Show drop-down 
list, select AL-All Home 
and Transferred-In.  

 

3 To sort information, click 
the column header once to 
sort in descending order 
and twice for ascending.   

 

The Filter icon may also 
be used to search specific 
information.  Select the 
filter a second time to 
remove the filter. 

 

 

4 Review the information 
from Employee 
Information View. 

 

   

NOTE: Neil Newby’s information is incomplete.  The Pay Rule column displays 
“Needs Update” and other information is missing. 
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Employee Information View Column Description 

Column Description 

Pay Rule Indicates how an employee earns time (i.e. Exempt vs. Non-Exempt, Overtime\Comp 
Time, etc.) 

Primary Labor 
Account Name-Full 

The Agency/Division/Work Location/Manager ID/Job Classification Code to which the 
employee is assigned. 

Hire Date The employee’s date of hire. 

Employment Terms Indicates if an employee qualifies for Holidays 

Current or Arrears Indicates if an employee is paid current or in arrears 

Schedule Group Indicates the assigned schedule group of an employee 

Assigned Manager The manager to whom the employee is currently assigned 

 

People Editor 

To view the employee setup in eSTART, use Go To>People Editor or Related Items>People Editor.  

This view provides information on the employee’s hire date, user ID, pay rule, etc.  View information using 

the left menu from the Person tab or the Job Assignment tab.  A manager cannot edit any of the 

information on these pages but may contact the Agency Administrator if changes are needed.  
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Locating Employees Using Quickfind  

Related Items>Quickfind may also be used to access the employee’s timecard. You may use other 

eSTART customized views to access timecards, but this page is designed to help you locate an employee 

by the name or ID. If you are unsure of the spelling of an employee’s name or know only some of the digits 

in an employee’s ID number, you may include wildcard characters to help you find the employee with only 

partial information. 

 

Wildcard 
Character 

Description Example 

     ? 

     _ 

  

A question mark or 
underscore indicates a single 
character occupies a position 
in the search string. 

10?? finds all employees whose ID contains 4-digit numbers 
starting with 10. 
 

Sm_th finds all employees whose last name starts with “Sm” and 
ends with “th” and has one letter in the center. 

     * 

     % 

  

An asterisk character or a 
percent symbol indicates 
multiple characters may 
occupy a position in the 
search string. 

*, s* finds all employees whose first name begins with the letter S. 
 

%1 finds all employees whose ID number ends with the number 1. 
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Using the Work & Absence Summary Calendar  

You may use the Work & Absence Summary calendar to identify trends in worked and time off events for 

employees. The calendar-like display makes it easy for you to see whether an employee has a pattern of 

taking time off or of arriving late on a specific day of the week. You may see trend information such as the 

following: 

• Number of days the employee has arrived late to work or left early 

• Number of days the employee has taken sick or annual leave 

• Days the employee has missed punches 
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Exercise 

You are scheduled to deliver a performance review with Sandy Stamp this week. Prior to the meeting, you 

would like to research her calendar for the year. Access the Work & Absence Summary calendar to review 

Sandy’s attendance. 

Steps 

1 From the Related Items pane, 
select Work and Absence 
Summary. 

 

2 Select All Home and Transferred 
In from the Show list. 

 

3 Select Sandy Stamp from the 
Name & ID list. 

 

4 Select the Previous Month from 
the Time Period drop-down list.  
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Steps 

5 Select the View Width option to 
review attendance events in a 
weekly calendar, monthly 
calendar, or in multiple months.  

Click Apply. 

For example, to see how many 
attendance events the employee 
has over a month, select Month 
and then click Apply.  

 

6 (Optional) Select one or more 
days and click Day Detail for 
more detailed information.  

 

7 (Optional) To see a legend of all 
color and visual indicator 
meanings, click the Legend 
button. 
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Reviewing Time and Attendance Data 

Using the Inbox to View/Send Messages 

My Inbox allows you to manage tasks and email messages sent via eSTART. In particular, the Messages 

tab allows you to create, read, reply to, and delete messages using eSTART’s internal messaging system. 

Employee requests for leave are one example of a typical message managers will receive. 

 

Exercise 

Steps 

1 From the Related Items pane, 
select My Inbox. 

 

2 From the Messages tab, select 
the message you want to 
review and click Open. 

 

NOTE: You may also double 
click to open a message. 

3 What do you want to do? 

• Click Close to close the 
message. 

• Click Reply to compose a 
message. 

• Click Delete to remove the 
message from the Inbox. 

• Click Print to send the 
message to a printer. 

• Click Help to access online 
help for this feature. 

 

4 Close the Message window.  
Then close the Inbox tab. 

 

 

 

NOTE:  Users who have an Agency email account will also receive these 
messages in their mailboxes. 
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Generating Reports 

You may generate reports on a daily, weekly or pay period basis, or any time you need information to 

accomplish your business tasks.  

Exercise 

For auditing and validation purposes, you want to review all your employees’ timecard hours and totals for 

the pay period in a report format. Select the Time Detail report to review this information.  

Steps 

1 From the Related Items pane, 
select Reports Manager. 

 

 

NOTE: You may also run a report 
for a specific set of employees by 
selecting the employees in a 
customized view and choosing Go 
To>Reports Manager. 
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Steps 

2 From the Select Reports tab, click 
the plus (+) to the left of the 
Timecard category to display its 
contents.  

  

3 Click the Time Detail report.  

 

NOTE: A description of the report 
displays on the right pane. 

Also, reports that have (Excel) at 
the end of their names are 
available in Microsoft Excel 
Document (.xls) format.  All other 
reports are available in Adobe 
Acrobat Document (.pdf) format. 

 

4 Select AL-All Home and 
Transferred-In from the People 
drop-down list. 

 5 Select Current Pay Period from 
the Time Period drop-down list. 
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Steps 

6 Select one or more available 
options to identify the report 
information you need. 

 

NOTE: Options may vary by report. 
 

7 This report is only available in 
Adobe format, so the Output 
Format field cannot be changed. 

8 To generate a report, click Run 
Report. 

 

9 After selecting Run Report, the 
Check Run Status tab displays. 

The Status column displays 
Waiting.   

Click Refresh Status.  

The Status column displays 
Complete once the application has 
finished the report. 

 

 

10 Once Status is Complete, click on 
the report name to select it and 
either: 

• Click the View Report button 
to use menu options. 

• Or double-click the report 
name to view.  

11 (Optional) To print the report to a 
local printer, select the Print 
button. The report may also be 
saved.  
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Here is an example of a Time Detail report. 
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Setting Up Report Favorites 

If you run the same report with the same options regularly, you may save the report as a favorite. You may 
run the report as needed without having to reset your options. Favorites display as a new category at the 
top of the list.  

Exercise 

Since you use a modified version of the Exceptions report often, you would like to retain the criteria for 

regular use.  You decide to save this report as a favorite. 

Steps 

1 Select the Exceptions report. 

 

2 Click Create Favorite. 

3 In the Favorite Report field, name 
the report Pay Period Exceptions. 

 

 

 

4 In the Author’s Remarks field, 
enter descriptive data (optional). 

5 Select the options that you would 
like to see in the report. 

All options are in the Selected 
window.  If only certain options are 
needed, move All selections to the 
Available window, then select the 
options that are desired. Hold down 
the CTRL key for each selection. 
Use the left and right arrows to 
move the selections to the Selected 
pane. 

NOTE: Options may vary by report. 

6 Click Save Favorite. 

7 Confirm that the report is displayed 
in the Favorites category.  
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Working with Time Off Requests  

Using the Manage My Requests Widget  

The Manage My Requests widget summarizes all requests in one window and provides all supporting 

information needed to process requests. Requests may come from employees or other managers, such as, 

manager delegation requests. In the Manage My Requests widget, managers may process requests one 

at a time or simultaneously process multiple requests of the same type. Managers may also filter the list of 

requests displayed in the widget and sort the list by column. 

 

 

Component Description 

Request Type This field enables managers to filter the requests that are listed based on the 
request type. 

Request Default Status This field defaults to the most common request statuses but allows managers 
to filter the requests to view other statuses. 

Request Detail/Accrual Tabs These tabs display different information relevant to the selected request. 

Request Actions These buttons enable managers to perform actions related to processing 
employee requests. 

Time Period/Hyperfind The Time Period drop-down allows you to select the timeframe for which you 
want to view schedules and timecard data.  There is also a Range of Dates 
icon to set your own time frame as well as a Hyperfind drop-down for selecting 
the group of employees to view. 
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Exercise 

Edward Exempt has submitted two time-off requests. You want to review and approve each of his 

requests. 

Steps 

1 To access the Manage My 
Requests widget, click on the 
Request Manager Alert icon (on 
the right) and choose Time Off. 

 

 

 

2 Leave the default values or select 
new values in the Time Period 
and Show fields. 

 

3 Confirm the default values or 
select new values in the Request 
type and Request status fields. 

 

NOTE: The Request Status 
button lets you limit which 
statuses display. For example, 
you may only want to view 
Submitted requests. 

 

For this exercise, leave defaults. 
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Steps 

4 Edward has two requests.  The 
first one in the list is pre-selected. 

 

5 To view the detail on the selected 
request, select the Request 
Detail tab or the Details icon at 
the top of the page. 

 

6 To view Edward’s accrual 
balances, select the Accruals tab. 

7 To approve, refuse, or perform 
another action on the selected 
request(s), click the applicable 
button.   

For this exercise, select Approve. 

 

Another method it to right-click on 
the request and choose the action 
from a pop-up menu.  This can be 
used to apply the same action to 
multiple requests, if desired. 

 

 

8 From the Approve Time Off 
Request page, verify the 
information and, if applicable, 
select a comment from the 
Comments drop-down list and/or 
enter text in the Notes field. 

Also, verify requests for Hours 
were submitted in 15-minute 
increments and that the start time 
is also in 15-minute increments. 

 

9 Click the Approve button. 
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Steps 

10 Select the remaining Time Off 
request.   

Click the Approve button. 
 

11 The Approve Time Off Request 
page displays for this request. 

Click Approve. 

 

12 Click Refresh to update the Alert 
icon. 

 

13 Close the widget.  
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Finalizing Timecards 

Reviewing Time Data at the End of the Pay Period 

Preparing to approve the timecards is extremely important to ensure that your employees’ time and leave 

events are accurate.  Several tools are available in eSTART to aid in this process. 

Manage My Requests  

1. Access the Manage My Requests widget to ensure that all time off requests have been 

appropriately acted upon.  This widget is accessed from the Request Manager Alert icon or from 

Related Items>Manage My Requests.  Any requests in Submitted, Pending, Cancel Submitted or 

Cancel Pending status must be addressed. 

 

NOTE:  If unapproved time off requests are present, the manager will receive a notification the second day 

after the end of the pay period.  On the third day, if unapproved time off requests are still present, the 

administrators and timekeepers receive the notification. 

Reconcile Timecard 

2. As you have already seen, the Reconcile Timecard widget helps you to identify timecard 

discrepancies at the end of a pay period so that you may perform final edits. You must correct all 

exceptions before time data is signed off by Administrators. Otherwise, employees may not get 

paid correctly for that pay period. This view is accessed from the Manager Workspace. 
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Employee Hours View 

3. The next step is to ensure the timecards contain the correct number of hours for the pay period.  

Select My Views>Employee Hours View in the Previous Pay Period. This provides a view of 

employee regular hours, non-worked hours, total hours, overtime and comp hours. Review the 

information on this page for any possible issues with employee time and correct any missing or 

incorrect time as needed. 

 

Note that the total hours for Sandy Stamp are fewer than the required hours for the pay period and 

Edward Exempt’s total hours are greater.  Complete the exercise to research and correct these issues.   

Exempt employees are assigned to an Auto-PFS schedule, so their lunch time is automatically deducted. 

When a time off request with a midday or partial day time frame is approved, the system determines 

whether the employee’s remaining shift contains at least 4:01 consecutive hours, either in the morning or 

afternoon portion of the schedule.  If the employee’s remaining shift does not contain at least 4:01 

consecutive hours, the lunch will not be auto-deducted which may require manual edits by the 

manager.  Such is the case with Edward Exempt. 

Exercise 

The total hours of Sandy Stamp and Edward Exempt are not correct.  

Steps 

1 Select Sandy Stamp and Edward 
Exempt in the list and select Go 
To>Timecards. 

 

2 Sandy Stamp’s timecard contains 
“late in” exceptions and does not 
have the correct total hours for the 
pay period.  

 

Add one hour of Annual Leave to 
Sandy’s timecard for each day that 
she was late. 
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Steps 

3 • Select the Insert Row button for 

each of the dates.   

• Select Annual Leave Taken 
from the Pay Code drop-down. 

• Key 1 in the Amount column for 
each date. 

• Select Calculate Totals to 
confirm that Sandy’s time is now 
correct. 

• Save the timecard. 

 

4 Scroll to Edward Exempt’s 

timecard. 
 

5 The timecard page displays. Note 
that one of the dates in Edward’s 
timecard shows 9 total hours 
instead of 8.  This is due to a 
midday partial time off request.  

The lunch time was not auto 
deducted since neither the morning 
nor afternoon shift was at least 
4:01 hours. 

 

6 Change the 1pm time in the 
timecard to 2pm.  

NOTE: This correction may also be 
made to the schedule via the 
Schedule Editor.  

 

7 Select Calculate Totals to verify 
the hours are now correct. 

 

8 Right-click on the punch, select 
Add Comments and choose Time 
Off Request Adjustment.   

• Click OK. 

• Save the change. 

 

9 Close the Timecards tab.   

Click the Refresh button to update 
the Employee Hours View page.  
Verify that total hours are now 
correct. 

 

 

 

Exempt Employee Schedule Types Auto PFS Rules for Lunch Deduction 

8-hour Employee The lunch will be deducted when the shift length is 4:01 hours. 

9-hour Employee The lunch will be deducted when the shift length is 4:31 hours. 

10-hour Employee The lunch will be deducted when the shift length is 5:01 hours. 
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Pay Period Close View 

4. The Pay Period Close widget is also useful for making a final review of your employee time records 

and displays indicators for employee and manager approvals. You may access employee 

timecards from either widget to make final corrections and approve employee timecards.  This view 

is accessed from My Views>Pay Period Close View. 

 

 

 

NOTE 
A reminder to approve timecards will be sent to all employees’ inbox the day after the end of 
the pay period. Users who have an Agency email account will also receive these messages 
in their mailboxes. 
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Approving Timecards 

After you finish editing your employees' timecards, you need to approve them to indicate to Payroll that they 

are ready for processing.  

NOTE: All manager approvals must be removed before edits can be made to the timecard.  

Exercise 

You have reviewed and performed all necessary edits to your employees’ timecards. You now approve the 

timecards for the previous pay period on each timecard.  

NOTE: As a rule, your non-exempt and hourly employees should have approved their own timecards 

before you approve them. The timecard will display with a light tan color if the employee has 

approved it.  For purposes of this exercise, employee approval has not been completed. 

Steps 

1 Pay Period Close should still be 
open from the previous exercise. 

 

NOTE:  You may also use 
Reconcile Timecard for selecting 
your employees. 

 

       

2 From the Time Period drop-down 
list, select Previous Pay Period. 

 

From the Show drop-down list, 
select Al-All Home and 
Transferred-In.  

 

 

3 Choose Select all Rows to select 
the employees in the list.   

Then select Go To>Timecards. 

 
 

 

4 The timecard of the first person in 
the list displays, but all are in the 
Name drop-down.  

There are also a scroll buttons to 
the right that may be used to move 
between the employees’ timecards.  

 



eSTART Course Guide for Managers   

 

63 

Steps 

5 On the first employee, select 
Approve Timecard>Approve 
Timecard. 

  

 

6 A temporary verification message 
will display at the top of the 
timecard after approval and the 
color of the timecard will change to 
light green. 

NOTE:  See table below for 
timecard color indicators. 

 

 

7 Scroll to the next employee in the 
list and choose Approve 
Timecard>Approve Timecard. 

 

NOTE: Any remaining exceptions 
on the timecard must be addressed 
before approving. 

 

8 Continue scrolling through each 
timecard and approving each one. 

 

9 Close the Timecards tab.  

10 Refresh the Pay Period Close 
View page.  

The number “1” should display in 
the Manager Approval column for 
all employees whose timecards 
were approved.  

 

Approval Type Visual Indicator 

Employee approval When a timecard is approved by an employee, the cells in the timecard turn 
light tan or orange. 

Manager approval When a timecard is approved by a manager, the cells in the timecard turn light 
yellow. 

Employee and Manager 
approval 

When a timecard is approved by both an employee and a manager, the cells in 
the timecard turn light green. 

Agency Administrator Sign off When a timecard is signed off, the cells in the timecard turn light gray. 

 

 

Best Business Practice 

Each non-exempt or hourly employee must approve his or her timecard. This helps to 
ensure its accuracy before manager approval is applied.   
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Performing Additional Manager Tasks 

Requesting Backup Coverage 

You may temporarily delegate your manager tasks in eSTART to another manager. The other manager 

may perform your tasks using their own user names and passwords. For example, they may modify 

schedule shifts for absent employees, or review, edit and approve timecards. This allows the business 

process to keep moving even when you are not there. All edits they perform are recorded and assigned to 

their names for audit purposes. 

Exercise 

You are out of the office for two days. You send a delegation request to Junior Manager so that you may 

temporarily assign your timekeeping tasks to him. This will ensure that your employees’ timecards are 

processed for payroll on a timely basis. 

Steps 

1 From the Related Items pane, 
select Temporary Delegation. 

 
 

2 From the list of actions, select 
Mgr_Delegation. 

 

3 The Create Delegation window 
opens. 

NOTE: If another delegation 
assignment exists, click Create 
New Delegation. 

 

4 From the Delegate drop-down list, 
select Junior Manager. 

Select today’s date from the 
Start Date field and tomorrow’s 
date from the End Date field. 

Select Manager Role from the 
Role drop-down list. 

 

 

5 Click Save & Close. The 
application sends the delegation 
request to the other manager’s 
Inbox. 
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Accepting or Declining Backup Coverage Requests 

When another manager sends you a request to cover his or her timekeeping and scheduling tasks, the 

application automatically places a task in your Inbox. The delegation request specifies the start and end 

dates and the role you will assume.  

Exercise 

For this exercise, log off as Johnx.Manager#.  Log on as Juniorx.Manager#. 

John Manager is going to be away attending a conference next week. He sent you a delegation request 

that you will review and accept. 

Steps 

1 Select the Request Manager 
Alert icon to open it.   

 

2 Click on Mgr_Delegation. 

 

The Manage My Requests 
widget displays. 

  

3 Highlight the request and click the 
Details button. 

 

4 The Accept Delegation radio 
button is the default.   

The Decline Delegation may be 
selected. 

The Comment field is optional.   

 

5 Click Save & Close. 

 

NOTE: eSTART automatically 
sends a message to the delegator 
to confirm that you have accepted 
or declined the delegation 
request. 

 

 

NOTE 

A message will also display from My Inbox>Tasks.  The request may also be accepted or 
declined by double-clicking the request there. 
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Switching to Delegated Roles 

After you accept a delegation request, the application automatically provides access to the tasks defined in 

the role profile on the specified start date. A Switch Role link displays as a quick link so that you do not 

have to log on as the manager who delegated the tasks to you. The link identifies which role you currently 

are working.  

Exercise 

John Manager delegated his tasks to you (Junior Manager) this week and you are ready to perform his 

timekeeping tasks. You do not need to log off as yourself and log on as the other manager because you 

may switch roles while logged on with your own user name and password.  

Steps 

1 Click the Switch Role icon found 
just to the left of your username at 
the top of the Navigator window. 

 

NOTE: If you do not see the down 
arrow, log off and then log on 
again using your own user name 
and password. 

 

 
2 Click to select the manager whose 

tasks you will perform as his or 
her delegate. 

3 The username at the top of the 
Navigator now displays your 
name and the name of the person 
whose role you have assumed.  

 

 

 

NOTE 

You may perform any management functions for the delegating manager.  However, you may 
be able to view your own employee information, but you will not have the ability to edit or 
approve your own timecard, time off request, etc. 
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Cancelling the Delegation 

The delegation rights automatically expire on the end date. However, you may end the delegation earlier if 

you wish. 

Exercise 

For this exercise, log off as Juniorx.Manager# and log back in as Johnx.Manager#. 

You (John) had delegated your management tasks to Junior Manager for two days. However, you 

returned the next day, so you will cancel the delegation.  

Steps 

1 From the Related Items pane, 
select Temporary Delegation. 

  

2 From the list of actions, select 
Mgr_Delegation. 

 

3 Select Remove Existing 
Delegation. 

 

4 Click Next. 

5 Select the existing manager 
delegation to be cancelled and 
click Delete. 

 

6 The Delete Confirmation 
message displays. 

Click Close. 

 

Junior will no longer have the 
option to switch role.  He will 
receive an email message about 
the cancellation. 
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Extended Leave for Managers 

It is important that you consistently and accurately administer State of Alabama’s leave policies. To make 

this happen, you need to manage employees paid and unpaid leave time in an efficient and timely 

manner. eSTART supports your ability to perform leave management tasks such as submitting leave 

cases for employees, reviewing leave cases and allocating/tracking leave amounts for an employee. 

eSTART Leave: 

• Automates the process of administering leave policies. 

• Helps State of Alabama achieve compliance with required federal, state, and local mandates. 

The Leave Process 

The Leave process automates the administering and tracking of paid and unpaid leave policies. Managers 

may easily track both continuous and intermittent leave and add leave time against an employee’s open 

leave case. In addition to centralizing administration of leave policies throughout State of Alabama, 

employees benefit from the consistent application of leave policies to individual leave cases. 
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Managing Leave 

Exploring Leave Tools in eSTART 

The navigator is your starting point for creating and maintaining your employees’ time and leave information. 

There are two key tools below that help you to perform common leave tasks, such as entering your 

employees’ leave takings and monitoring leave cases.  

Accessing Leave Views 

eSTART includes the following leave Views: 

• Leave Cases View 

• Leave Hours View 

Either of these Views may be used as a starting point for viewing and monitoring employee leave cases. 

Leave Views are accessed from the same workspace that timekeeper views are accessed.  
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Exploring the Leave Hours View 

The Leave Hours View is especially useful for viewing total leave hours. It also provides other information 

about each leave case in eSTART, including: 

• Leave Case Status 

• Last date of committed paid and unpaid leave time 

• Leave end date (if one is provided) 

Key Information in the Leave Hours View 

 
 

Column Description 

Leave Case Status Indicates the status of the leave case for the specified time period, such as Open, Closed, 
Pending, Submitted, or Retracted. 

Leave Case Code Type of leave, such as Self or Family. 

Leave Start Date This is the first day that the employee takes leave. 

Leave End Date This is the employee’s expected return date. 

Committed Paid/ 
Unpaid Leave Time 

The Committed Paid Leave Time and Committed Unpaid Leave Time columns show the 
amount of paid and unpaid time that has been committed to the schedule or timecard in 
the selected time period. 

Last Date/Committed 
Paid/Unpaid Leave 
Time 

The Last Date/Committed Paid Leave Time and Last Date/Committed Unpaid Leave Time 
columns show the date of the last committed paid and unpaid amounts. 

Total Paid/Unpaid 
Leave Takings 

The Total Paid Leave Takings and Total Unpaid Leave Takings columns show the total 
amount of paid and unpaid leave that an employee has taken. 
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Exploring the Leave Cases View 

The Leave Cases View is especially useful for viewing leave reasons and leave frequencies. It also 

provides other information about each leave case in eSTART including: 

• Leave case status 

• Leave category 

• Initial leave request date 

Key Information in the Leave Cases View 

 

 

Column Description 

Leave Case Status Status of a leave case, such as Open, Closed, or Submitted. 

Leave Category Type of leave, such as Self or Family. 

Leave Reason Indicates a more specific leave such as serious illness or birth. 

Leave Case Code Type of leave, such as Self or Family. 

Leave Frequency Indicates whether the employee is on continuous or intermittent leave. 

Leave Case Approval Status Indicates whether a leave request is approved, pending or denied. 

Initial Leave Request Date Date the leave request was made. 

Leave Start Date Date leave starts for an employee. 

Documents Overdue A check in this column indicates that a document is overdue. 

New Leave Requests A check in this column indicates additional time requested on an existing leave 
case. 

Leave End Date The expected date on which an employee returns to work. 
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Reviewing Leave Time in a Timecard 
After leave has been approved and committed for an employee by your Leave Administrator, you may view 

those leave hours in your employee’s timecard. Leave time displays differently than other pay codes in the 

timecard. Leave time displays in black text with the prefix “LV” and is not editable. 

Exercise 

Penny Punch is out on leave. You want to review her timecard to confirm that the leave hours are accurate.  

The Leave Cases View was selected in the previous exercise.  Remain on this page. 

Steps 

1 Select Next Pay Period selected 
in the Time Period drop-down. 

Select AL-All Home and 
Transferred-In from the Show 
drop-down.   

 

2 Select Penny Punch then select 
Go To>Timecards. 

 

3 Review the leave takings in the 
timecard for the selected time 
period. 

The LV entry describes the type of 
leave used. 

The Totals tab provides a 
summary for the time period 
selected. 

NOTE:  FMLA cases use leave in 
a certain order, based on the type 
of case.  See the Extended 
Leave Cascade job aid for this 
information. 

 
 

 

NOTE 

Contact your Leave Administrator to discuss any necessary modifications to an employee’s 
leave hours. 
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Requesting Leave for an Employee 

Occasionally, it is necessary to initiate a leave request for an employee who is unable to do so, for example, 

when an employee is already on sick leave. 

The Leave Case Editor is a tool in both Leave Views that allows you to electronically complete a request 

for leave on the employee’s behalf. Once you submit the leave request, it is electronically sent to the Leave 

Administrator who will check the employee’s eligibility and process the proper documentation. 

The Leave Case Editor may be accessed via the Go To menu in either the Leave Hours View or the Leave 

Cases View as illustrated below.  The Leave Case Editor is also available from the Related Items pane. 

 

Exercise 

Yesterday, employee, Edward Exempt, called to tell you that he will be unable to come to work due to an 

injury he sustained while working in his yard. He is unable to work and does not know when he will return. 

Edward has asked you to initiate a leave of absence request. You want to access Edward Exempt’s record 

and initiate a leave request on his behalf. 

Steps 

1 From the My Views drop-down, 
select Leave Cases View. 

 

2 From the Time Period drop-down 
list, select Current Pay Period. 

From the Show drop-down list, 
select All Home and 
Transferred-In. 
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Steps 

3 Select Edward Exempt and then 
click Go To>Leave Case Editor. 

 

 

 

4 In the Leave Start Date field, 
enter the date the employee will 
begin the leave or select a date 
using the calendar icon. 

For this exercise, today’s date is 
the default.  Leave this date 
selected. 

 

In the Initial Leave Request 
Date, enter the date the employee 
requested leave or select a date 
using the calendar icon. 

For this exercise, today’s date is 
the default.  Leave this date 
selected. 

 

5 In the Leave Category field, 
accept the default value of FMLA. 

 

6 From the Leave Reason drop-
down list, select the appropriate 
leave reason. 

 

For this exercise, select Serious 
Health Condition. 

 

NOTE: After selecting a reason, 
the Leave Case Code is 
automatically populated. 

 

7 From the Leave Frequency drop-
down list, select the appropriate 
frequency of the employee’s 
leave.  

 

For this exercise, select 
Continuous. 
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Steps 

8 In the Effective Date field, leave 
today’s date selected.  

9 In the optional Temporary 
Mailing Address field, enter a 
mailing address, if necessary. 

 

10 In the optional Details field, enter 
any other information that may be 
relevant to the leave request. 

 

11 Click Save. 

 

12 Close the Leave Case Editor tab.  
Refresh the Leave Cases View 
page to view the new case. 

 

 

 

NOTE 

Initially the manager may not have all the information needed to open the leave case.  
Additional information may need to be added later. 
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Adding Leave Time to the Timecard 

A manager may add a pay code to the timecard for an employee who has an open and approved FMLA or 

Military leave case.  This must be verified BEFORE adding the pay code to the timecard of an employee.   

NOTE:  Do not add these pay codes to an employee’s timecard unless both conditions are met. 

Exercise 

Sandy Stamp has an open and approved intermittent leave case. She requested four hours of leave time 

for Wednesday of the current pay period to take her mother to physical therapy. Add the FMLA Sick Leave 

Taken pay code to her timecard. 

Steps 

1 Select the Leave Cases View. 

 

From the Time Period drop-down 
list, select Current Pay Period. 

 

Select All Home and Transferred-
In from the Show drop-down. 

 

2 From Leave Cases View, verify 
that Sandy has an open and 
approved leave case from the 
Leave Case Status and Leave 
Case Approval Status columns. 

 

3 Select Go To>Timecards link. 

 

 

4 From the Pay Code drop-down in 
the Timecard, select FMLA Sick 
Leave Taken. 

Save the timecard. 
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Committing Leave Time to the Timecard 
 

The Quick Leave Editor is another tool that allows you to enter leave time for an open leave case, 

especially an employee who has ongoing doctor’s appointments or physical therapy. The Quick Leave 

Editor lets you view, add, and modify leave time that was previously entered using the Leave Case Editor. 

Exercise 

Sandy Stamp has an open and approved intermittent leave case. She requested four hours of leave time 

for Wednesday of the next pay period to take her mother to physical therapy. You want to use the Quick 

Leave Editor to enter and commit the intermittent leave time to her timecard. 

Steps 

1 From any My Views widget or 
Related Items>Quickfind, select 
Sandy Stamp.   

From the Time Period drop-down 
list, select Next Pay Period. 

 

Select Go To>Quick Leave Editor. 

 

 

 

 
 

 

 

 

NOTE:  If the employee has more than one active leave case, the window below will display.  Select the 
applicable leave case by clicking the link in the Leave Cases column.   
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Steps 

2 The Leave Case Editor will 
display.   

In the Leave Time Amount 
column, click the cell for the 
applicable day(s) and enter 4 leave 
time hours. 

NOTE: The number of hours must 
always be entered in 15-minute 
increments. 

 

Hours for multiple days may be 
entered if needed. 

Click Save. 

  

3 To review the time from the 
timecard, select Go 
To>Timecards. 

 

 

 

NOTE 

The pay codes may also be added directly to the timecard, or you may contact your Leave 
Administrator if you are unable to commit the time.  Pay codes added directly to the timecard 
will have the prefix of FMLA or Military, depending on the type of case.  Pay codes added 
using the process above or by the Leave Administrator will have an LV prefix. 

Also, an employee may request the time by submitting a time off request, provided he/she 
has an open and approved extended leave case.  The available selections will vary based on 
the type of leave case.  See the Employee Pay Codes for Time Off Requests job aid for a 
list of these pay codes. 
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Generating Leave Reports 

Employee leave information is available in several different leave reports. You may generate leave reports 

on a daily, weekly, or pay-period basis, or any time you need information to accomplish your business tasks. 

For example, you may generate the Leave Hours Detail report to review the types of leave hours for each 

shift that has been committed to an employee’s timecard.  

Leave reports are generated in the same way as other reports, using the process described in the Reports 

Manager section of this guide. 

Types of Leave Reports 

The Leave Hours Detail report lists detailed leave information for employees with open or closed leave 

cases for the requested time period.  

The Leave Hours Summary report lists, for each employee, all open or closed leave cases in the 

requested time period, as well as any requested leave cases in the requested time period.  
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Using the Employee Workspace 

Sometimes you will need to access your own employee records. For example, you will need to submit your 

own requests for time off as an employee. To access your time and calendar data, you have access to a 

workspace called the Employee Workspace. You have fewer rights when accessing your own information 

than when accessing your employees’ records. 

Accessing the Employee Workspace 

Steps 

1 To access the Employee  

Workspace, click the Add 

Workspace (+) tab to the right of 

the Manager Workspace tab. 

 

2 Select the Employee Workspace 

option. 

From this workspace you have access to: 

• My Timecard 

• My Timestamp 

• My Calendar 

• Audits 

• Change My Password 

• My Activities (not used) 

• My Extended Leave Requests 

• My Inbox 

• My Reports 
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Primary and Secondary Widgets 

The Employee Workspace includes three default widgets as well as a Related Items pane. These widgets 

can be in a primary position or secondary position. In most cases, you will work in the primary widget.  

 

You can move a secondary widget into the primary position by clicking the gear icon in the upper-right 

corner of the widget and selecting Pop-out. The current primary widget will shift into the secondary 

widget position. Other available widgets may be accessed from the Related Items pane. 

 

Restoring the workspace 

After selecting one of the secondary widgets, the Refresh icon on the Employee Workspace tab may be 

used to return the workspace to the timecard view. 
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Using My Timestamp 

If you are an employee who is required to punch from your workstation, you will use the My Timestamp 

widget to record your punches during your shift. 

Exercise 

You want to record a punch for the start of your shift. 

Steps 

1 Locate the My Timestamp widget.   

 

NOTE: The date and time of the 
last recorded timestamp displays 
on the My Timestamp widget. 

  

 

2 Click the Record Timestamp 
button. 

 

3 A message displays indicating 
whether the punch was accepted. 

 

4 The punch will not immediately 
display in the timecard.  After a 
few seconds, select the Refresh 
button to update the timecard. 

 

 

 

NOTE 
There is a separate URL for the Quick Time Stamp application.  This allows employees to 
quickly perform their time stamp without logging into the eSTART production application. 
 
https://estart.alabama.gov/wfc/applications/wtk/html/ess/quick-tslite.jsp 

https://estart.alabama.gov/wfc/applications/wtk/html/ess/quick-tslite.jsp
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Reviewing and Approving your Time using My Timecard 

Your primary widget is your timecard. You will use the My Timecard widget to review your timecard and 

approve your time for the pay period. eSTART allows you to electronically sign by “Approving” the 

document. 

Exercise 

You want to review your timecard and approve it for the Previous Pay Period. 

Steps 

1 Verify that My Timecard is the 
primary widget. 

 

2 Select Previous Pay Period to 
review. 

 

3 Review your timecard and notify 
your manager if any exceptions 
are present. 

 

NOTE: You do not have rights to 
edit your own punches. 

Blue = Excused Absence 

Red = Exception (see manager before approving) 

Green = Manager has marked as reviewed 

 = Manager has added a comment 

Purple = Populated by eSTART 

4 Select the tab at the bottom of the 
page to open the lower portion of 
the screen. 

 

Review the Totals section of the 
timecard, which contains the 
breakdown of your worked and 
non-worked time. 

 

 

5 Once the manager has made any 
corrections and the totals are 
correct, you may approve your 
timecard. 

To approve your timecard for the 
selected time period, click the 
Approve Timecard drop-down 
and select Approve Timecard. 

 

6 Timecard is Approved message 
temporarily displays at the top of 
the widget and the color of the 
timecard changes to light tan. 
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Selection Menu Options on the My Timecard widget 
 

 
 

 

 

NOTE 
A reminder to approve timecards will be sent to your inbox the day after the end of the pay 
period. Users who have an Agency email account will also receive these messages in their 
mailboxes. 

 

  

Timecard Options Description 

View Use this option to view only days with exceptions in the timecard. 

Approve Timecard Use this option to approve the timecard or to remove approval. 

Print Timecard This feature allows the information from the timecard to be printed. 

Refresh Updates the timecard with the most current data.  It is most used to update the 
timecard after using the Timestamp. 

Calculate Totals This option is disabled and not available for all employees. 

Save This option is disabled and not available for all employees. 
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The Totals Area of My Timecard Widget 

Click the gray tab in the lower section of the timecard view to expand the Totals section of the timecard.   

 

The Totals tab displays the overall timecard totals and how the employee hours are tracked. 

 

The Accruals tab displays accrual codes and available leave balances based on the date selected.  
Accrual balances may also be viewed from the My Accruals widget. 

 

The Historical Corrections tab is for viewing historical corrections. The Audits tab is for viewing any 
audit trail information. 

  

Accruals Tab Description 

Accrual Code The type of accrual balance, such as Annual Leave or Sick Leave. 

Accrual Reporting Period The leave reporting period (current year). 

Accrual Available Balance The accrual balance from the payroll system as of the date in the As of drop-down. 

Accrual Planned Takings The total amount of time scheduled to be taken, from the As of date through the 
end of the Reporting Period (12/31). 

Accrual Pending Grants The total accruals projected from the As of date through the end of the Reporting 
Period (12/31). The projections assume the employee will work the appropriate 
number of hours to earn the accruals. 

Accrual Ending Balance The accrual balance as of December 31st, including Pending Accruals and Planned 
Usages. 
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Viewing My Calendar 

The My Calendar widget is used to view your schedule information and to view and request time off. You 

can hover over a shift to view more detailed information. You may also change the calendar view and use 

the filter at the top to show and hide certain item types in the calendar.   

The following illustration shows a week view. 

 

Navigating in the Calendar 

The following table describes the actions that display information in a calendar for data analysis: 

Action Step 

Time Period/Range of Dates Set the desired time period or date range. 

 

Calendar View 

Select  to view one day across the screen.  

Select  to view one week across the screen (default). 

Select  to view one month across the screen. 
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Action Step 

Quick Scroll Scroll to the previous or next week. 

 

Visibility Filter Select the Visibility Filter to display or hide elements such as time off 
requests, holidays, scheduled pay codes, or scheduled shifts. Uncheck 
an item to remove it from the display. 

 

Request Time Off 

Select  to submit a Time Off Request. 

Scheduled Shift Hover your cursor over a shift to view details of the shift. 

 

Time Off Requests Requests display in the calendar once they are approved.   
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Requesting Time Off Using the My Calendar Widget 

The My Calendar widget displays your schedule for the current pay period as well as previous and 

subsequent pay periods. It also provides a consistent, easily accessible way to request or cancel time off. 

eSTART forwards the requests to your manager to handle appropriately. 

Exercise 

Your childcare provider will be unavailable next Thursday and Friday and you will need to take the 

afternoons off. Submit a time-off request for four hours of Annual Leave each day starting at 1 p.m. for 

next Thursday and Friday. 

Steps 

1 In the Employee Workspace, 
locate the My Calendar widget.  

 

NOTE:  This widget may still be 
open from the previous exercise.  
If so, skip to step 3. 

 

2 Click the gear icon on the  
My Calendar widget and select 
Pop-out. 

3 Select the Time Period that 
includes next Thursday and 
Friday. 

 

4 Click in the area circled in red to 
select the start date. 

 

5 Click Request Time Off. 
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Steps 

6 The Request Time Off window 
displays. 

 

Confirm that the Start and End 
Dates are correct.  Click in the 
field of each date to edit, if 
needed. 

 

NOTE: The “+” can be used to 
insert another row for additional 
leave.  See the Tip below before 
using this function. 

 

 

 

 

7 Verify your leave accrual 
balances. 

 

8 Select the Pay code from the 
drop-down list. 

 

NOTE:  Use the scroll bars or 
hover the mouse pointer over the 
pay code to view the entire 
description. 

 

9 Select a Time Unit. 

 

If you select Full Day, your 
scheduled hours will be used to 
determine the amount of time 
charged for each day. Continue to 
Step 12. 

 

If you select Hours, you must 
specify a Start time and Daily 
Amount for the leave time to be 
used for each requested day. 
Continue to step 10.   

NOTE:  These fields must be 
entered in 15-minute 
increments. 

 

For this exercise, select Hours. 
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Steps 

10 Enter the Start time (with am/pm) 
for the leave and the number of 
hours requested in the Daily 
Amount field. 

 

11 (Optional) Enter Notes for the 
request. 

 

12 Click Submit. 

 

13 The request has been submitted 
for approval and displays in the 
employee’s calendar with the 
Submitted (arrow) icon. 

 

NOTE: Once the requested time is 
approved by your manager, the 
schedule will automatically be 
updated to show only the 
scheduled leave time for the 
requested days. 

 

14 Hover on the green Submitted 
arrow icon to see a pop-up of the 
request details.   

 

Right-click the green arrow for an 
Options menu. 

 

• Select Details to see the 
details of the request. 
  

5. Select Cancel Request 
to cancel or retract the 
request. 

 

   



eSTART Course Guide for Managers   

 

91 

Steps 

15 The Cancel Time-Off Request 
page displays. 

 

Enter Notes if needed. 

 

Then click the Cancel Request 
button.  
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Request Symbols 

The symbols below will display on the request in the calendar, indicating the status of the request. 

 

 Submitted - for approval or cancellation 

 Retracted - prior to manager approval 

 
Approved - for taking or for cancellation 

 Pending 

 Refused  

 

 

Best Business Practice 

All requests for time off should be submitted through the time clock or eSTART application. 

Submit multiple requests whenever a request spans across unscheduled workdays to prevent 
the request from displaying in the timecard with zero hours for those days.  A request that spans 
a holiday will result in the leave being charged on that day, which would require cancelling and 
resubmitting the request. 

An employee who is not assigned to a work schedule should always select Hours when 
submitting a leave request.  Since there is no assigned schedule, selecting Full Day will result 
in errors. 

 

 

Tip 

Cancelled requests must be approved by your manager.  

You cannot cancel part of a request. All days associated with a request are cancelled. For 
example, if you originally requested three days off and then decide you only need two days, 
you must cancel the original request and submit a new request for two days. 

Also, using the “+” selection to add another row will allow you to enter multiple requests with 
one entry.  But all requests entered this way will be grouped together and if one must be 
cancelled, all will be cancelled.  It is more efficient to enter separate requests. 

 

 

NOTE 

Employees have access to specific pay codes when submitting a time off request.  Additional 
selections are available if the employee has an open and approved extended leave case.  The 
selections will vary based on the type of leave case.  See the Employee Pay Codes for Time 
Off Requests job aid for a list of these pay codes. 
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Annual Leave Cascade  

A cascade defines how leave time is processed in the system. If the employee does not directly select 

Comp Time, Excess Annual Leave, etc. when submitting their request, but selects Annual Leave 

instead, their leave will be used, based on the time of the year, in the order as described in the chart below: 

Annual Leave Cascade 

January 1 – July 31 August 1 – December 31 

Comp Time Personal Day 

Excess Annual Leave Excess Annual Leave 

Annual Leave Comp Time 

 Annual Leave 

 

 

NOTE 
The following are not impacted by the cascade: 

• Follow your agency’s policy and procedures regarding the usage of personal leave 
days before August 1st. 

• Your holiday banked time may be scheduled by your supervisor in the quarter in 
which it was earned. 

 

If the cascade makes a change to the type of leave originally submitted, the timecard will display the 

information as indicated below.   

 

In this example, the original request was for two hours of annual leave.  Since the employee had one hour 

of Comp Time and had Excess Annual Leave time, the cascade reversed the original request for annual 

leave, used the Comp Time first, then the Excess Annual Leave. 

 

A comment is added to each entry in the timecard to indicate the change was made by the cascade.  

These comments may be viewed from Go To>Audits.  Select Comments from the Category drop-down 

to view the comments. 
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Audits 

The Audits tab is located on the Related Items pane. All timecard changes are logged here for audit 
purposes, including timecard approval. The page also lists punches made from timestamping. 

The Category and Type of Edit drop-down lists may be used to filter the information in the audit log. 

 

 

Column Description 

Date/Time The original date/time of the entry. 

Type The type of edit that was performed. 

Account The account to which the edit is attributed, if different from the primary account. 

Pay Code/Amount The pay code and number of hours assigned, if applicable. 

Work Rule The work rule used with the edit, if different from the employee’s primary work rule. 

Override The type of entry that this edit is replacing or cancelling, if applicable. 

Comment The comment attached to the edit. 

Edit Date/Time The effective date and time of the edit. 

User The user name of the person who edited the transaction. 

Data Source The component of the application where the edit occurred. 
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Exercise 

You want to review all manual edits that have been made to your timecard. 

Steps 

1 From the Related Items pane, 
select Audits. 

 

2 My Audits is the default selection 
in the Category drop-down. 

 

All is the default selection from the 
Type of Edit drop-down list.  

 

Other types may be selected to 
narrow the results.  However, do 
not change the options for this 
exercise. 

3 View the results. 

 

4 Scroll down to the bottom of the list 
to view the changes made to the 
timecard. 

 

5 To close the Audits widget, hover 
your cursor over the Audits tab 
and then click the X.  
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Changing Your Password 

If you have a Network/Email ID, your Logon ID is your email address; your password is your network 
password. Do not use the Change Password widget in eSTART. Contact your agency Help Desk/IT staff 
to change your password. 
 
If you do not have an email address, your Logon ID will be firstname.lastname and your initial password 
will be P@ssw0rdxxx (xxx = your agency number). You are required to change your password at first login.  
Then you will use the Change Password widget to change your password. 

Exercise 

Follow the steps below to change your password. 

Steps 

1 From the Employee 
Workspace, open the 
Related Items pane and 
select Change My 
Password. 

 

2 In the Old Password field, 
enter the password you 
want to replace. 

 

3 In the New Password field, 
enter the new password. 

4 In the Verify Password 
field, re-enter the new 
password. 

5 Click Save. 
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Using My Inbox 

When you submit a request for time off, the manager’s response displays in your eSTART Inbox. You can 

review these messages in My Inbox.  

Example 

You want to review any messages you have received in eSTART.  

Steps 

1 Select My Inbox from the Related 
Items pane. 

 

2 Select Messages tab to review 
your messages.  

 

3 To read a message, select the 
message and click Open. 

 

4 After you have reviewed the 
message, select one of the 
following: 

• Click Reply to respond to 
the message. 

• Click Close to close the 
message and return to 
the Inbox. 

• Click Delete to remove 
the message from the 
Inbox. 

• Click Print to print the 
message to your local 
printer. 

 
Select Close. 

 

5 To close the My Inbox widget, 
hover your cursor over the My 
Inbox tab and then click the X.  
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Using My Reports 

There may be times when you would like to print information such as your leave accrual balances, schedule 

or timecard data. eSTART provides three employee reports for this information using the My Reports 

widget.  When View Report is selected, the report will display and may be printed using the web browser’s 

Print options. 

Exercise 

Steps 

1 Select My Reports from the 
Related Items pane. 

 

2 Select Time Detail from the 
Available Reports. 

For this exercise, select Time 
Detail. 

 

3 Select Previous Pay Period from 
the Time Period drop-down list. 

4 Click View Report. 

 

The report will display.  

 

You may print the report using the 
browser’s File>Print options. 

5 Close the My Reports tab. 

 
NOTE: The Primary Account button may be used to view a history of labor level changes. 
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Using My Extended Leave Requests 

Employees can submit a request for extended leave for FMLA (Family and Medical Leave Act) or Military 

Leave using eSTART. Employees who are already on leave of absence can request additional time against 

an existing leave case using the same workspace. Requests for new leave cases and additional leave time 

are forwarded to your Agency’s Leave Administrator.  

Exercise 

You have upcoming surgery and need to request FMLA leave from work. Submit a continuous leave request 

for FMLA time.  

Steps 

1 Select My Extended Leave 
Requests from the Related 
Items pane. 

 

2 In the My Leave Requests 
calendar, click Request New 
Leave Case from the Requests 
list. 
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Steps 

3 From the Leave Category drop-
down list, select the type of 
leave: 

Choose FMLA. 

 

NOTE: (*) Asterisk - Denotes a required field 

4 From the Leave Reason drop-
down list, select Serious Health 
Condition. 

5 From the Leave Frequency 
drop-down list, select 
Continuous.  

6 From the Leave Start Date drop-
down calendar, select 1st 
Monday of the following 
month. 

7 From the Leave End Date drop-
down calendar, select the date 
when you expect the leave to 
end. 

 

NOTE: You can leave this field 
blank if the end date is unknown. 

 

For this exercise, leave the field 
blank. 

8 Leave Same hours each day 
selected in the Leave Hours 
field.   

9 In the Approximate Daily Leave 
Hours field, enter the number of 
hours you expect to take each 
day.   

 

For this exercise, key 8. 

10 The Temporary Mailing 
Address is an optional field that 
can be used to inform of the 
address of the relative you are 
assisting or the rehab center 
where you will be staying, etc. 

11 Enter an explanation of the leave 
request in the Describe Details 
of Your Request field. 

 

Key Surgery. 

12 Click Save. 
 

A message displays: 
Notification has been sent to 
leave administrator. 
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Steps 

13 Choose Next Month from the 
Time Period drop-down. 

 

Click Apply. 

 

14 The Leave Request displays as 
an entry in the My Leave 
Requests calendar. 

 

 

 

15 To review your leave requests, 
select View My Leave Cases 
from the Requests list. 

 

 

 

NOTE 

You may cancel a leave case request from the same My Extended Leave Requests calendar 
as well. Select a leave case and click Cancel Leave Case in the Requests list. Enter a reason 
for cancelling the request and click Save.  

 

  



 eSTART Course Guide for Managers 

 

102 

NOTES: 


